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Вы знаете, какой атрибут у настоящих, не-

киношных хакеров считается главным? За-

сечки на клавиатуре? Банка пива? Оклади-

стая борода и хвостик? Крутое прозвище,

скажете, что-то вроде tiRaNoSauR? Уже

теплее, но не то. Главным атрибутом у оте-

чественных, да и за границей выросших

«кул-хацкеров», как мне кажется, является

логотип, выполненный в ASCII-графике. То

есть тот, что был не нарисован, а искусно

набран буквами или другими символами. 

И надо сказать, что многие художники по-

добной андеграундной живописи достигли

немалых высот в своем творчестве. В Ин-

тернете можно встретить не только витие-

ватые надписи в стиле граффити, но даже

целые картины. Монстры, собаки, рыбки —

и все это набрано обыкновенным компью-

терным шрифтом без засечек. Диву иногда

даешься, до чего додумываются…

Вам тоже хотелось бы такой нарисовать, но

не знаете как? Тогда спросите у создателей

программки со странным названием «Хы-

тыпик». Или еще проще, скачайте и запус-

тите эту утилиту — и вы все сможете сде-

лать сами, причем не прикладывая ровным

счетом никаких усилий. Ошибиться здесь

невозможно — в окне всего три кнопки:

«Открыть», «Посмотреть» и «Сохранить».

Вы, стало быть, запускаете какую-нибудь

маленькую BMP-картинку, загружаете в

браузере ее преобразование и сохраняете,

если понравится.

Вполне возможно, что, попробовав «Хыты-

пик», вы решите украсить свой сайт краси-

вым необычным логотипом.   
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Хытыпик 0.5
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Windows

К сожалению, не дал мне бог таланта ху-

дожника. Сколько раз пытался научиться

рисовать — все без толку, только «черный

квадрат» и получается. Так, наверное, и

прошла бы моя жизнь без изобразительно-

го искусства, если бы не программа Icon

Studio, разработанная украинскими про-

граммистами. С помощью этой утилиты да-

же самый неважный художник, вроде меня,

сумеет без проблем создать кучу симпа-

тичных иконок и курсоров.

Вы можете нарисовать картинку будущего

значка самостоятельно. С помощью инст-

рументов «Карандаш» (Brush) и «Ластик»

(Erasing tool) эта задача будет по силам

даже ребенку. 

Но можно поступить и хитрее: взять любую

готовую иконку (Open icon from source)

или выдернуть ее из EXE- или DLL-файла, а

затем обработать в этом редакторе. Начер-

тать, например, свои инициалы на значке

«Мой компьютер».

Иконку можно сделать цветной или черно-

белой. Набор же заранее заготовленных

рисунков одного размера и содержания

легко превращается в полноценный ани-

мированный курсор («Animation -> Make

*.ani cursor file»). 

Буквы в значок проще всего добавить с по-

мощью специального меню («Effects -> Add

text element»). Размер их почему-то огра-

ничен кеглем 16, но и этого достаточно.

Обязательно воспользуйтесь и еще одним

3D-эффектом («Effects -> Use3D button ef-

fect»), превращающим иконку в выпуклую

кнопку.   
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Icon Studio 2.1

Laguna Ukraine group

www.laguna.by.ru
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ç‡ËÒÛÈ ÒÂ·Â
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Очень часто принятые по умолчанию па-

раметры Windows настолько далеки от

идеала, что невольно даже закрадывает-

ся подозрение: уж не умышленно ли это

сделали разработчики. Ведь они просто

взяли и отдали реестр своей самой за-

крытой в мире операционной системы на

откуп сторонним программистам. Правь-

те, мол, сколько душе угодно, только ни-

чего альтернативного не придумывайте. 

И надо признать, идея «улучшательства»

быстро захватила программистские и поль-

зовательские массы. Создан уже целый

класс утилит «твикеров», призванных ус-

корить работу «Окошек». 

У каждого из нас могут быть свои при-

страстия насчет софта вообще и подоб-

ных оптимизаторов в частности. Лично

я в последнее время чаще всего запус-

каю «Редактор настроек Windows», по-

скольку эта утилита компактна, не требует

инсталляции, ничего от себя самовольно в

реестр не прописывает. А главное — все

здесь написано по-русски. Во всплыва-

ющих подсказках на родном языке вам

сразу посоветуют, что отключить можно,

а что нежелательно. Оптимальные зна-

чения для тех или иных параметров и

вовсе указаны рядом с каждым пунк-

том. 

Маленькая программа позволяет отредак-

тировать параметры запуска Windows, ее

графическую оболочку, файловую систе-

му, сетевые и прочие настройки. Отдель-

ный раздел посвящен безопасности рабо-

ты и сохранности данных.   

êÄáêÄÅéíóàä

ëÄâí êÄáêÄÅéíóàäÄ

ìëãéÇàü êÄëèêéëíêÄçÖçàü

éèÖêÄñàéççÄü ëàëíÖåÄ

Редактор настроек Windows 1.08

MultiWorks Technology

www.mwt.ru
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Как известно, нам песня «строить и жить

помогает». Ни одно серьезное застолье в

России без хорового пения не обходилось

и не обходится. Но не все одинаково хоро-

шо поют. Кто-нибудь обязательно сфаль-

шивит или слова напутает. 

Для таких горе-певцов музыканты приду-

мали специальную систему караоке. Про-

граммисты перенесли эту систему на язык

компьютерных технологий. В конце кон-

цов, чем мы, пользователи ПК, хуже всех

остальных граждан? 

Конечно, имеем право петь. И возмож-

ность такую имеем благодаря программе

vanBasko Karaoke Player. Эта утилита про-

игрывает KAR-файлы, музыка в которых

MIDI, а слова народные. Сотни таких KAR-

файлов вы найдете, например, на сайте

www.karaoke.ru. 

Скачав их и запустив Karaoke Player, вы

увидите пять автономных окон: сам проиг-

рыватель, окошко для загрузки плейлистов,

настройки параметров звучания, клавиату-

ра для виртуального пианино и, наконец,

табло для текста песен. 

С управлением системой караоке, я думаю,

вы справитесь без труда. Просто жмите на

«Play» и пойте во все горло или хотя бы

вполголоса, наблюдая за бегущей строкой

текста. Настроек в Karaoke Player совсем

немного. В основном они связаны с фор-

мой представления текста песен: каким

шрифтом, на фоне какой картинки и т. п. В

окне «Control» с помощью ползунков вы

сможете также подрегулировать скорость,

тональность и громкость звучания.   
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vanBasko Karaoke Player  2.52

vanBasko Software

www.vanBasko.com
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Признаюсь честно: я питаю некоторую

слабость к «умным» программам, что назы-

вается, с элементами «искусственного ин-

теллекта». К этой категории относится ути-

лита сравнения графических файлов

Image Dupless, написанная на C++ Олегом

Тарлапаном. 

Эта смышленая, хотя и запускающаяся по-

чему-то только с системного диска про-

граммка поможет навести порядок в зале-

жах разного рода картинок любителям

цифровой фотографии, да и всем странст-

вующим по Сети. Она определит дубликаты

как в уже существующей коллекции, так и

в ее сравнении с новыми файлами. За-

метьте, речь идет не о текстах, а именно об

абстрактной графике. 

Для начала, правда, нужно создать саму га-

лерею — своеобразную базу данных из

имеющихся картинок (кнопка «Создать га-

лерею из заданной директории»), — что-

бы затем можно было в ней найти одина-

ковые изображения. Или сравнить вновь

полученные графические файлы с уже об-

работанными на предмет совпадения

(«Сравнить новые изображения с галере-

ей»). И надо признать, дубликаты в заби-

той донельзя папке «Мои документы»

были довольно быстро найдены и практи-

чески без ошибок. Что особо впечатляет

— копии Image Dupless распознала даже

среди разных по размеру фотографий.

То есть увидела, например, не только са-

му иллюстрацию, но и ее уменьшенную

«превьюшку».   
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Kerio  Personal  F i rewal l  2.1

Kerio Technologies

www.kerio.com

shareware

39, free for home use

Windows

Web-серфинг сродни настоящему путеше-

ствию. Отправляясь в дальнюю дорогу, мы

захватываем с собой все самое необходи-

мое, не забывая, естественно, об аптечке и

предметах гигиены. Точно так же, запуская

программу-«звонильщик» для связи с пу-

лом интернет-провайдера, мы должны

иметь наготове необходимые средства

компьютерной защиты, под которыми в

данном случае подразумеваются антиви-

рус и брандмауэр. Причем последний дол-

жен быть в обязательном порядке. Боль-

шинство компьютерных вирусов еще

нужно активизировать, а вот пробраться на

ваш системный диск злоумышленник мо-

жет, как говорится, в режиме реального

времени. И что он там натворит — одному

хакерскому черту известно.

Так что хотим мы этого или нет, а запускать

брандмауэр придется. Слава богу, про-

грамм подобного класса предлагается сей-

час немало. Одной из них является бес-

платная для домашнего использования

Kerio Personal Firewall. Это очень удобный

мобильный брандмауэр, чем-то отдаленно

напоминающий Zone Alarm. По крайней

мере, легкостью настройки и цветовой ин-

дикацией интернет-активности иконки в

трее. Точно так же, как и в Zone Alarm, при

запуске, допустим, браузера вам необходи-

мо будет либо разрешить его (Permit), либо

запретить (Deny). Есть смысл также прика-

зать брандмауэру запомнить ваше решение

(Create appropriate filter rule…) в отноше-

нии той или иной программы.   



Я, как и все нормальные люди, люблю чи-

стоту и порядок. Но мне, как и многим

другим, то и дело не хватает времени для

их наведения. Да, откровенно говоря, и

желания иногда тоже. Вот если бы эту ру-

тину можно было бы автоматизировать.

Нажал кнопку — и порядок. Как в ком-

пьютере, где у меня теперь поселилась

замечательная бесплатная утилита «Ска-

нер временных файлов».

Она выискивает и удаляет временные

файлы — TMP, BAK, GID и иже с ними. В

принципе, подобную зачистку можно ор-

ганизовать и с помощью стандартных

средств Windows, но благодаря «Сканеру

временных файлов» она существенно уп-

рощается. Процесс уборки становится не

только более простым, но и гораздо бо-

лее детальным. Не только папка «Temp» и

«Корзина», но и весь жесткий диск будет

освобожден от ненужного виртуального

барахла.

При запуске не требующего инсталляции

«Сканера» вы вправе выбрать ручной или

автоматический режим поиска. В первом

случае вы должны будете определить об-

ласть для проверки, а во втором — про-

грамма сама, без посторонней помощи,

проверит папки для временных файлов.

Но и только. Поэтому я лично пользуюсь

третьим вариантом зачистки под назва-

нием «Поиск мусора на дисках». На мой

взгляд, только в этом случае сканирова-

ние папок получается наиболее полным и

всесторонним.   
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Сканер временных файлов 1.35

AmelSoFT Ë ç. Ç. ÄÏÂÎË˜Â‚ 

http://amelso.narod.ru/

ts_135.htm
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Не знаю, что читали вы в детстве, а я вот

любил книжки о коварных вражеских шпи-

онах и наших доблестных разведчиках.

Приоткрывал, можно сказать, тайны нелег-

кого дела «бойцов невидимого фронта».

Помнится, не раз в тех книжках упомина-

лись загадочные шифроблокноты, прочи-

тать которые можно было только со специ-

альным кодом.

Программа Camouflage — из их числа, но с

поправкой на новые компьютерные техно-

логии. Дело в том, что эта утилита прячет

один файл внутри другого. Стало быть,

можно, например, скрыть внутри фотогра-

фии пышногрудой блондинки какой-ни-

будь крайне важный текст. И никакой враг

об этом никогда не догадается. 

При первом запуске Camouflage предложит

добавить к контекстному меню файлов еще

две пункта: Camouflage («Скрыть») и Unca-

mouflage («Раскрыть»). Первый из них

позволит вам внедрить требуемый доку-

мент в файл-матрицу. В процессе шифров-

ки этот рисунок, а также пароль к нему

следует указать. В результате вы получите

две идентичные с виду картинки, одна из

которых будет немного больше по «весу».

Ей, кстати, можно задать атрибут Read Only.

Вот так в эпоху Интернета может незамет-

но передавать секретные сообщения

«Алекс» «Юстасу». В заключение информа-

ция к размышлению доморощенным хаке-

рам: спрятанные внутри картинок исполня-

емые файлы не запускаются одновременно

с файлом-матрицей.  
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Этой программе можно смело присваи-

вать имя Николая Федорова. Был такой

странный русский философ, основопо-

ложник теории всеобщего воскрешения.

Пока заветная мечта его не осуществи-

лась в реальном мире, но зато в вирту-

альном кое-что сделать удалось. 

Программа Drive Rescue — яркое тому

свидетельство. Эта утилита восстанавли-

вает утерянные данные на дисках. Про-

цесс регенерации утерянного осуществ-

ляется в три этапа. Во-первых, нужно

запустить сам Drive Rescue, во-вторых,

определить в разделе «Deleted» конкрет-

ный диск и директорию, где пропали дан-

ные, и, наконец, скопировать найденный

файл («Object -> Save to») в какую-ни-

будь другую папку. Об этих удаленных

файлах мы можем узнать следующее: имя

при жизни, дату «смерти» — удаления,

вес и состояние «тела» в настоящее вре-

мя. Оно может быть или хорошее (good),

или не очень (poor). Хотя, если речь идет

об архивах или исполняемых файлах, га-

рантии даже при самом благоприятном

варианте не может быть никакой. 

Кроме того, с помощью Drive Rescue

можно попробовать восстановить дан-

ные, потерянные в результате крушения

системы (Find lost data), или даже обна-

ружить «пропавший» из-за сбоя FAT-

таблицы физический диск (Find lost dri-

ve). Правда, гарантий здесь еще

меньше. Но зато, если уж повезет, то уж

повезет.   
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TEdit изначально разрабатывался как

HTML-редактор, но затем автор решил осу-

ществить в нем поддержку формата TXT.

Так он стал еще и текстовым редактором.

Поэтому вы можете не только создавать и

редактировать текстовые файлы, но и фай-

лы в формате HTML. Чтобы каждый раз не

сохранять файл и не запускать браузер, в

программу был добавлен собственный, ко-

торый позволит практически «на лету»

проверить то, что было создано или отре-

дактировано. Это значительно ускоряет и

облегчает работу. При создании нового

HTML-документа программа автоматически

подставляет в него шаблон с необходимы-

ми тэгами (<html>, <head>, <title> и

<body>), что также сказывается на време-

ни и удобстве работы. 

Если же идет работа с текстовым файлом,

то программа предлагает пользователю

сложную (но не для пользователя) систе-

му закладок. Это особенно удобно при

чтении файла большого размера. Но есть

и ограничения: использовать можно

только не более 10 закладок, причем при

переходе на каждую из них программа

грузит нужный файл, а затем переходит к

тому месту, где была установлена эта за-

кладка. TEdit оснащен весьма несложным

интерфейсом, но при этом он удобен и

помогает выполнять большинство необ-

ходимых действий. 
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Audio Conversion Wizard — это уникаль-

ный конвертер цифровых аудиоформатов,

выполненный как Wizard, который быстро

и легко помогает конвертировать: из WMA

в MP3, OGG Vorbis, WAV PCM; из WMA в WMA

(возможно изменение параметров получа-

емого звукового файла); из MP3 в WMA 8,

OGG Vorbis, WAV PCM; из MP3 в MP3 (с из-

менением параметров); из OGG Vorbis в

WMA 8, MP3, WAV PCM; из OGG Vorbis в OGG

Vorbis. При этом допустимо копирование

ID3 Tag v2 (если данные тэга были запол-

нены у конвертируемого файла, то они мо-

гут перейти к получаемому файлу). Если

же эти данные не устраивают пользовате-

ля, то их можно поменять непосредствен-

но на одном из шагов программы. Audio

Conversion Wizard позволяет работать

(конвертировать) как с одним определен-

ным файлом, так и сразу с несколькими,

при этом нагрузка на пользователя вовсе

не становится больше — вся его работа

по-прежнему сводится к пошаговому вы-

бору того, что и как надо сделать с аудио-

файлами. Программа использует наиболее

современные и быстрые аудиокодеки. На-

пример, осуществлена поддержка формата

WMA 8 (его качество кодирования звука

на 30–50% лучше, чем у WMA 7), MP3-ко-

дирование работает с LAME-кодеком вер-

сии 3.91, а OGG-кодирование использует

последнюю модификацию Vorbis SDK. При

конвертировании есть возможность доба-

вить полученный файл в плейлист, напри-

мер Winamp.    
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KeyNote — весьма гибкий многофункцио-

нальный блокнот, доступ к которому все-

гда осуществим нажатием всего на одну

клавишу, даже если работа идет в другом

приложении. Основной идеей программы

является то, что несколько различных тек-

стовых файлов собраны в один-единствен-

ный файл, что не приведет к тому, что нуж-

ные записи рано или поздно затеряются

где-то в дебрях жесткого диска. Это зна-

чит, что нет необходимости открывать сра-

зу несколько файлов, а достаточно всего

один раз создать единый файл и поместить

все свои записи непосредственно в него.

Благодаря тому, что этот файл может иметь

древовидную структуру, весьма легко об-

наружить необходимую информацию. Ин-

терфейс KeyNote полностью изменяем, что

позволит пользователю максимально под-

строить ее «под себя». Программа позво-

ляет комбинировать одиночные и древо-

видные записи, включает в себя редактор

текста с форматированием, позволяет лег-

ко смешивать записи различных типов в

один файл, сохраняя при этом кодировку.

Со своими мощными возможностями фор-

матирования текста, легким в навигации

интерфейсом и дополнительными возмож-

ностями программа может стать «убийцей»

стандартного Microsoft Notepad и даже по-

сягнуть на MS Word, хотя до него KeyNote

пока еще далеко. В дистрибутиве можно

найти файлы macros.txt и plugins.txt, в ко-

торых рассказывается о создании макро-

сов и плагинов.  


